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Vectorworks is a registered trademark of Nemetschek Vectorworks, Inc., in the United States and other
countries. Windows is a registered trademark of Microsoft Corporation in the United States and other countries.
Macintosh is a trademark of Apple Computer, Inc., registered in the United States and other countries. Adobe,
Acrobat, and Reader are registered trademarks of Adobe Systems in the United States and other countries.

The information in this book is distributed on an “as is” basis, without warranty. While every precaution has been
taken in the preparation of this book, neither the author nor Nemetschek Vectorworks shall have any liability to any
person or entity with respect to any loss or damage caused or alleged to be caused directly or indirectly by
the information contained in this book or by the computer software described in it.
For more Vectorworks training information or to purchase more copies of this book, please visit
www.Vectorworks.net/training, or call us at (410) 290-5114.
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Introduction: How to Use this Manual
Vectorworks users to get started and trained quickly. Here are some things that will help you:
1. Work right through the manual. Some of the exercises may not seem appropriate. Don’t
worry about that; try them anyway. The information in this manual will not find its way into
your head if you don’t complete the exercises.
2. Reading the manual is good, reading the manual and watching the movies is better.
However, reading the manual, watching the movies, and completing the exercises has
the best results. Watch the movies, try the exercise, and then play the movie again.
3. Allow yourself two weeks to work through this manual. Some of my clients allow their new
workers two full weeks to work through this manual. They are expected to complete the
manual in one week and then repeat the exercises. In the second week they should be
able to repeat the exercises a couple of times. I have been told that, at the end of this
time, the workers are up to speed and are useful Vectorworks technicians.
4. This manual covers a lot of ground, and you might feel that there is too much content to
absorb. It’s all there for a reason. This is what you need to know to use Vectorworks well.

SAMPLE

Measurements are shown in both metric and imperial. Metric measurements are shown
first, followed by imperial measurements in brackets. If you are using metric, don’t type in the
imperial measurements; if you are using imperial, don’t type in the metric measurements.
Just use the measurements inside the brackets.
This manual comes as a hard copy with one DVD. There are two exercise folders on the DVD.
One is called “Architect Exercises,” and the other is called “Completed Exercises.” Copy both
folders to your computer. Copy the exercise folder to a location that will make it easy for you
to find. Save any training files that you work on to your exercise folder.
When you want to play a movie that is shown in the printed manual, insert the DVD into your
computer and open the file on the DVD called “Architect Tutorial Manual.pdf.” This is your
electronic copy of the manual, and it contains links to all the movies. Make sure that the
Architect Tutorial Manual.pdf opens with Adobe Acrobat Reader. Other PDF readers may not
play the movies correctly.
To play a movie from the electronic copy of the manual, move your cursor over the movie icon
(the cursor will change shape) and click once. When the movie is finished, it will automatically
close. Use Adobe Acrobat Reader to read the manual and play the movies; use Vectorworks
to do the exercises.
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Comments and discussions are shown like this.
• Instructions for you to complete are shown like this.
Tips: Useful tips are shown like this.
This manual builds on the Essential Tutorial Manual, which is designed to show you basic
concepts of Vectorworks, such as simple drawing, simple modeling, and basic file
organization. If you are unfamiliar with these concepts, you should get this manual and
complete it before you go any further.

New Ways of Drawing
When you are drawing in Vectorworks, draw the objects to the correct real-world sizes
regardless of the scale of the layer that you are working on.
It is much easier to maximize the potential of Vectorworks by using objects to draw with
because they can be easily edited (for example, doors, windows, rectangles, etc.). You
could say that Vectorworks is designed to draw with objects.

SAMPLE

When you want to draw shapes, you may be tempted to use lines and arcs to draw the shape.
Always try to draw with solid shapes, rectangles, and polygons. I have created a series of
exercises that show you how to make complex shapes out of simple shapes by adding the
shapes together or by clipping a portion of a simple shape away to make a complex shape.
It’s very important that you use these new drawing methods to draw your buildings,
landscapes, or engineering models.

Vectorworks Architect Workflow
In this manual we will be working through a domestic project for a client. Even though we
are using a domestic project, Vectorworks is designed to be used for commercial and
industrial work as well. The concepts we cover in this manual are useful in domestic and
commercial work.
One of the main concepts in using Vectorworks Architect is called Building Information
Modeling (BIM). What this means is that as you draw a wall in Vectorworks, it is more than
a plan representation of a wall. The wall has texture, knows when a window is inserted, and
can have information attached to it. Many parts of the Vectorworks drawing are much more
than they seem. A door, for example, is more than the plan representation of the door. It has
a model part, and you can attach information about the door, door hardware, or even the
supplier and cost of the door. This information can be generated as a report whenever
you want it.
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Live sections and elevations are a development of the Building Information Model that allow
you to keep the sections and elevations up to date as you change the form of the building.
In this manual we will start with an empty drawing file and work through the steps needed
to create a concept design, developed design, and contract documents.
Most times, you will start with a blank file, so that’s how we will start. This will give us the
opportunity to look at Document Setups: the page setup, the units setup, the dimension
settings, and text styles.
Our first task is to draw the existing site. We start with the property line. The property line is
the site plan, which you can draw from information like the certificate of title, Google Earth,
and so on. We will start using the information from the surveyor.
Then we will create a site model, which is a model representation of the spot levels on the
survey drawings. This allows us to see the constraints on the site as models in order to turn
the model around and look at the constraints from many different views.

SAMPLE

We will create our concept model using spaces. Spaces are great. They allow you to make a
model of your concept in a very short time. We can link this to our site to see how the concept
relates to the site constraints. This is an important step because we can easily make changes
to the concept model and see how the changes relate to the site constraints. We could check
the recession planes, solar studies, the effects of the neighbors, and so on. We can use this
to make better design decisions.
You could show the client the concept drawing at this point with the form of the building.
Showing the clients a model of the concept will help them to understand your visions, and it
will help to develop trust with your clients. Using BIM, we can then use the model to create
the drawings.
We will assume that the clients approve the design, so we can look at design development.
This means taking the concept and turning the spaces into walls, doors, windows, slabs,
roofs, and so on. We can copy the concept drawings and edit them to show the developed
design with very little extra work.
We will finish off the manual with a section that discusses ways of creating the contract
documents. There is more than one way to create the drawings, so we will look at the
concepts around creating the drawings, which will allow you to make your own choices.
When you finish this manual, you will have a file with most of the layers, classes, viewports,
and so on that you need for most two-story projects. This file can then be saved as a template
file, or you can use the file to start your next project by using the Save As… command from
the File menu.
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When you start Vectorworks Architect, it looks like this on a Windows machine:

SAMPLE

When you start Vectorworks Architect, it looks like this on a Macintosh:
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Step 1 File Setup
Document Setup
We will set up the file from the beginning, from a blank document. Vectorworks has set up
commands to make it easier to set up the file. When you have set up the file, it can become
a template file that you can use to start every new job, saving you a lot of setup time.

• Go to the Menu bar.
• Choose File > New...

SAMPLE
• This opens a dialog box for you to
choose Create blank document.

• A blank file opens with a layer scale
of 1:1 and a letter-size page.
• We should set up our page first.
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Step 2 Property Line
When you want to draw a property line (site boundary), you will notice that surveyors
usually use 0º for north while Vectorworks uses horizontally across to the right as 0º.
You may think that this causes us a problem. It doesn’t because we have a tool that will
translate the surveyors information into native Vectorworks information. This tool is called
the Property Line tool.

• Go to the Site Planning tool set.
• Select the Property Line tool to
draw the site.

SAMPLE
• Go to the Tool bar.
• Click on the Preferences button.

• Choose the Simple Dialog option.
• Click on the OK button.
In some countries, surveyors always
assume that the bearings are measured
from north through east so that true north
is 0º and true east is 90º. The simple
dialog box works very well for this
method. In other countries, you will need
to use N_E or N_W, depending on the
bearings from the surveyor.
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Step 3 Layer (Model) Setup
We need to break up the project into a series of manageable chunks to make it easier to draw
the building. We will use Stories to control the elevation heights, design layers for modeling,
and classes to control visibility and graphic style of object. If you are not familiar with layers
and classes, please refer to the Vectorworks Essential Manual, which has a series of
exercises to explain these.
It is essential to set up the layers and stories correctly, as these control many of the
building elements.

Stories
A story (storey) is a collection
of design layers (foundation,
slab, walls, and ceiling). The
story settings control the
elevation of the story relative
to other stories.

SAMPLE
When you have two or more
stories, you have two
collections of design layers.

The settings of each story are
relative to each other. When
you change the elevation of
one story, it can adjust other
stories above or below.
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Step 4 Creating the Site Model
Creating a site model and a building model is an area of Vectorworks that really shows
the advantage of working in 3D. With the site model we can visualize the site, the height-toboundary or recession plane constraints, the sun position relative to the site, and the shading
that other buildings, trees, and parts of the site will have on your building.
Building a site model gives you the ability to see on the screen what the constraints on your
site are. You can use the site model to help sort out the bulk and location on the site, which
is what we will be doing with our project.
Think of it this way. You have a tricky site with tight height-to-boundary problems. You build
a site model so you can quantify the constraints. You can build a mass block model to sort
out exactly how much you can build and where you can build it. Using a site model can help
you to resolve the levels on the site as well as resolving the area that you can build. When
you have sorted out the bulk and location, you can refine the design and use the recession
planes when you submit your drawings to the local planning authority.

SAMPLE

When you use Vectorworks this way, you can create a concept model in about 30 minutes.
This allows you to check the site constraints, solar analysis, and adjoining buildings. You
can use the concept model to make better design decisions.

What is a Site Model?

A site model is a way of looking at 3D data (spot levels or contours) in a way that allows you to
see complex models and plan representations. Vectorworks uses the 3D information to create
the models based on the data to help you understand the plan and model nature of your site.

How Does It Work?
First you have to input 3D data, such as spot levels, contours, or surveyor’s data files.
Then you ask Vectorworks to create a site model from this data. Vectorworks uses a set of
algorithms to analyze the information and then creates the plan and model representations.
The algorithms can be thought of as a set of mathematical assumptions that are used to
calculate these parts. Because of these assumptions, you may get some oddly shaped
contours or 3D models that don’t look as you expected. A site model is not reality; it is a
mathematical model of the data you give Vectorworks. The better the data you provide,
the better the site model will be.
When you create a site model, Vectorworks will make an object that can show one type
of information in a plan view (contours) and a different type on information if you are in a
model view (3D contours, extruded contours, etc.). Using this hybrid object is a good way of
combining the plan and model components into one object. If you are used to earlier versions
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Step 5 Quick Bulk and Location
Now that we have the site, we need the existing building. We really need to see the existing
building on the existing site before we start modifying the site model. This exercise is
important because it allows you to try out the size and location of the project before you
commit to it. It allows you to try out several concepts, with little additional work, to find the
optimum solution. When you are satisfied with the solution, you can use the spaces to
quickly create walls.

Creating the Lower Floor

SAMPLE
• Change layers to Floor-1.
• Change the layer options to
Active Only.
• The Navigation palette lets you
carry out both of these instructions
with the same palette.

• Make sure nothing is selected.
• Before we get started, set the
Attributes to a solid fill with a
thin line.
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Step 6 Concept Drawings
Now that we have our concept model, we can set up the concept drawings. We can do
this even though we haven’t completed the design.

Preparation
Using classes for your objects gives you a lot of flexibility for controlling and changing objects
and for creating drawings. We will have to create some classes, edit them, and assign objects
to these classes.

• Go to the Navigation palette.
• Right-click and choose New...

SAMPLE
• Create a class for existing areas.
• Choose Visible for the viewport
visibility.
• Check the option to Edit Properties...
• Click on the OK button.
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Step 7 Creating the Walls
Why use walls? First, most of you are drawing buildings and so need to show walls in your
plan. There are two ways to do this—either by drawing lines to represent the wall or by using
the Wall tool to draw all the lines and cavities on the wall that you specify. The Wall tool makes
it fast to draw a plan of a building.
For most architects and designers the Wall tool is fundamental to modeling a building. Mainly
you will be drawing plans to describe the work to be carried out. The Wall tool not only draws
the plan parts of the walls with cavities, cladding, and so on, but it also uses the layer heights
to extrude the walls for you. This is why it’s important to set up the layers first.
We will be creating wall styles. A wall style allows you to create a wall that you can reuse
again and again. A wall style will know how high it needs to be, as well as what components
(wall parts) should be in the wall. Wall styles can be copied from one file to another, and you
can make a library of wall styles for quick and easy access.

SAMPLE

If you need more information on joining walls, healing walls, and creating walls, refer to page 244.

Creating Basement Walls

• Change the active layer to Floor-1.
• Change the layer options to
Active Only.
• Use the Navigation palette for
this. It’s quick!
• Go to the Building Shell tool set.
• Choose the Wall tool.

• Before the Wall tool can be used, you
have to define the width of the wall (wall separation)
and any components (cavities) that you want to include.
• To set up the components and the
separation, click on the Wall
Preferences button on the Tool bar.
This will open the Wall Preferences.
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Step 8 Creating The Roof
We need to create a roof for our proposed design so that we can look at it in 3D and check
the proposed roof against the site model constraints. We can also use the roof to create our
elevations and sections for our concept drawing.
We will create the roof in three parts. The first part of the roof will be the existing roof, which we
may need to keep for existing and demolition drawings. Then we will build the roofs over the two
proposed extensions. That will give us enough roof to check our design in 3D, to check the
design against the site model constraints, and then come back and fix the roof to comply.

Existing Roof
To make the existing roof we need to select all the existing walls. The hard way to do this is
to select them one by one. And dragging a marque around the plan is not always successful
because you might have other information in the plan (proposed walls, furniture, etc.). The
better way to do this is to use the Select Similar tool. Select Similar gives you the opportunity
to define a filter for selecting items in the drawing.

SAMPLE
• Go to the Basic tool set.
• Choose the Select Similar tool.
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Step 9 Developed Design Drawings
Now that we know that our developed design plan will comply with the site constraints, we can
set up the concept drawings. We can do this even though we haven’t completed the design.
We haven’t resolved the structure. Walls, windows, and doors are missing, and there are no
sanitary fittings shown. There is a lot to do, but we can still set up the drawings now and fill
them in as we work on the design.

Plan Viewports
• Change layers to the main floor
layer (Floor-2).
• Draw a rectangle around the
existing walls.

SAMPLE
• From the Menu bar choose
View > Create Viewport...

• Answer Yes to the dialog box about
using the selected object as the
viewport crop, if it appears.

• We need a new sheet layer, so choose
Create on Layer pop-up menu and
create a New Sheet Layer.
• Name the Sheet Layer
002-Developed Design Plans.
• Name the viewport so that you can
use the Navigation palette, select the
viewport, and edit it.
• Click on the Layers... button and
check to make sure that just the
Floor-2 is visible.

• Click on the Classes... button to check
the classes. Turn off the proposed
classes. We will be adding more
classes, so we can use the Navigation
palette to come back and edit the class
settings for this viewport.
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Step 10 Doors and Windows
There are two main ways to deal with doors and windows in Vectorworks. First, there are the
standard doors and windows that come with Vectorworks, and then there is the WinDoor
manager that comes with Vectorworks Australia/NZ (there are movies for this on the
installation DVD).
Before we put in the windows and door in the lower floor, there is a
wall missing. The missing wall lines up with a wall on the floor above.

• Change layers to the
Floor-1 layer.

SAMPLE
• If the space is assinged to a
class, make that class invisible.
Space objects can be used for
the room labels.

• Make layer Floor-2 visible, and change
the layer options to Show/Snap Others
or Gray/Snap Others (use the
Navigation palette for this).
• Choose the Wall tool and then the wall
style that we made earlier for drawing
existing blockwork walls. This is easy if
you go to the Tool bar and click on the
Wall Style pop-up menu.
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Step 11 Site Modifiers
Now we will have to come back and modify the site in order to add more
information—like the foundations for the new parts of the building and the driveway.
You might notice that the site model sometimes has a bold red dashed border. This indicates
that the site model needs updating. Right-click on the site model and choose Update.
• Change layers to Site Plan.
• Select the design layer viewport.

SAMPLE
• Go to the Object Info palette.
• Click on the Layers... button.

• Turn off the layers that you don’t need.
This is a great trick, as you can turn off
layers that you don’t want to see for a
while and then turn them back on
again. You can’t do this with layer links.
• Click on the OK button.
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Step 12 Stairs
We will be making a new stair from the basement up to the new living area.
This will teach us about the stair object in Vectorworks and quick ways of working with
stairs. There are two stair tools we can use to create the stair from the lower floor to the
upper floor. The Stair tool and the Custom Stair tool can be used to show the stair on each
level of the building, using the layer elevations to calculate the stair geometry. The Custom
Stair allows landings at any angle whereas the Stair allows only straight and 90º landings.
Stairs can be saved as library objects in a file. You can save them in your office library, but
you can also save them in a special location in your Vectorworks folder so that you can pick
them when you start a stair.
• Change layers to the lower floor layer,
Floor-1.
• Select the Stair from the Building
Shell tool set.

SAMPLE
• Go to the Tool bar.
• Click on the Preferences button.

This dialog box opens. There are several
tabs on this dialog, and each tab has
several options.
You need to start with a standard
configuration, or a symbol from a library.
• Click on the Select Standard
Configuration... button.
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Step 13 Annotation
Drawings are fine, but without annotation they are incomplete. This chapter
shows you how to add a title block, notes, and other annotation techniques.

Standard Title Blocks (Drawing Border)
• Go to the Dims/Notes tool set.
• Click once on the Sheet Border tool.

SAMPLE
• As with all plug-in objects, go to
the Preferences button on the Tool
bar to set the preferences for your
drawing border.

• Choose the option for Fit to Page.
You have already set up the page
size for this drawing, so it’s easier
to use this rather than try to work
out the printed page size.
• Click on the Title Block... button.
This allows you to choose a sample
title block to use as the basis of your
title block. All these sample title blocks
are stored in the Vectorworks folder
and can be edited to suit your purposes.
• You can change your title block later
to a different one by clicking on the
Title Block... button on the Object
Info palette.
• Click on the OK button.
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Step 14 Working Drawings
The working drawings (construction drawings) will take up most of your time. However, they
use many techniques that you have already learned (text, notes, dimensioning, 2D drawing)
so we won’t need notes here about those techniques. What we will cover are general
strategies, and where we cover a new method or a new technique, we will have notes about it.
There are commands that will set up your drawings, provided that your drawings meet the
Vectorworks standards. But if you are like most architects and designers, you don’t use a
standard drawing setup, so the drawing setup will change depending on your project.
Let us start with the size of your drawings, as this will have a huge impact on the way that you
set up your drawings. If you use an A1 printer (or similar U.S. size), then you can get a lot of
information on your drawings. Your number of drawings may be reduced substantially and
thus serve as a big advantage.

SAMPLE
Drawing 01 - Site Plan

• Set up a sheet layer for your site plan
called 01 Site Plan.
• Set the Page Size to A1 (or to match
your printer). Refer to page 10.
• Create a new 1:200 site plan viewport
and place it on your drawing.
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SAMPLE

This tutorial manual is based on Jonathan Pickup’s successful Vectorworks Architect course taught in
New Zealand. The feedback from this course has been very positive and it has helped many clients
to use Vectorworks Architect and, just as importantly, to develop an office drawing system based on
Vectorworks organizing concepts.

This exercise-based tutorial manual covers:

• Basic concepts of layers and classes and
how they relate to developing your office
layer and class standard.
• Creating an office library.
• Using the Property Line tool.

• Creating and manipulating site models and
using them for height-to-boundary analysis.
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• Walls and the wall type library.
• Stairs and vertical transport.

• How to make a quick model of a project using
spaces for bulk and location analysis.
• Using annotation tools, title blocks, and the
note database to quickly annotate your plans.

